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Warranty and Liability 
 

Note The Application Examples are not binding and do not claim to be complete with 
regard to configuration, equipment or any contingencies. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for the correct 
operation of the described products. These Application Examples do not relieve 
you of the responsibility of safely and professionally using, installing, operating 
and servicing equipment. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time and without prior notice. If there are any 
deviations between the recommendations provided in this Application Example 
and other Siemens publications – e.g. Catalogs – the contents of the other 
documents shall have priority. 

We do not accept any liability for the information contained in this document. 

Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of fundamental contractual obligations (“wesentliche 
Vertragspflichten”). The compensation for damages due to a breach of a 
fundamental contractual obligation is, however, limited to the foreseeable damage, 
typical for the type of contract, except in the event of intent or gross negligence or 
injury to life, body or health. The above provisions do not imply a change of the 
burden of proof to your detriment. 

Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of Siemens AG. 

 

Security 
informa-

tion 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, solutions, machines, equipment and/or 
networks. They are important components in a holistic industrial security 
concept. With this in mind, Siemens’ products and solutions undergo continuous 
development. Siemens recommends strongly that you regularly check for 
product updates. 

For the secure operation of Siemens products and solutions, it is necessary to 
take suitable preventive action (e.g. cell protection concept) and integrate each 
component into a holistic, state-of-the-art industrial security concept. Third-party 
products that may be in use should also be considered. For more information 
about industrial security, visit http://www.siemens.com/industrialsecurity. 

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit 
http://support.automation.siemens.com. 

http://www.siemens.com/industrialsecurity
https://support.industry.siemens.com/cs/?lc=en-DE
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1 Task 

Introduction 

In existing SINAUT plants with SIMATIC S7-300/400 and the respective TIM 
modules for remote transmission, S7-1200 stations can now also be integrated 
using CP 1243-8 IRC (Industrial Remote Communication). 
 

In this example, a waste water treatment plant consists of two substations, one 
S7-1200 station and one S7-300 station. Both stations shall communicate with 
each other as well as with a central station. On the central station PC, the SIMATIC 
NET PC software, the SINAUT ST7cc software, and the WinCC software has been 
installed. 

For telecontrol communication, the ST7 protocol is used. 

Overview of the automation task 

The figure below provides an overview of the automation task. 

Figure 1-1 

Station 1 Station 2

ST7cc

WinCC

Central Station

S7-1200
S7-300

Internet

Pump 2Pump 1
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Problem description 

This application example should cover the following requirements: 

 An S7-1200 station shall be integrated into existing SINAUT plants with 
SIMATIC S7-300: 

– configuring a CP proxy in STEP 7 V5.5 

– configuring the CP 1243-8 IRC in STEP 7 V13 

– ST7cc configuration 

 The two remote stations (S7-300 and S7-1200) can send process tags to each 
other (cross-communication). 

 The two remote stations (S7-300 and S7-1200) send important process tags 
“event-triggered” to the central station. 

 The process tags are stored event triggered in an archive of the central station. 

 The central station monitors the status of the connected remote stations. 

The SINAUT central station and station 1 (S7-300) are interconnected via a 
cable-based Ethernet network. 

Station 2 (S7-1200 with CP 1243-8 IRC) is connected with the central station via 
redundant paths: 

 one path via cable based Ethernet network 

 one path via dedicated line. 

The simulated process shall be operated and controlled in the remote stations via 
WinCC. 

 

Note For the dedicated line, data transmission is performed at a speed of 19200 
bit/sec. This is much slower than the speed of Ethernet connections. 
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2 Solution 

2.1 Overview 

Schematic layout 

The figure below shows a schematic overview of the most important components of 
the solution: 

Figure 2-1 

Station 2Station 1

Central station1

2
3

Control center

 SIMATIC NET

 WinCC Runtime

 SINAUT ST7cc 

Runtime

Configuration

 STEP 7 V5.5 , 

STEP7  V13 

 ST7 Engineering 

Software V5.5

 ST7cc Configuration

 WinCC Engineering

PC/PG

TIM 4R-IE

S7-300 with TIM 3V-IE 

Advanced

S7-1200 with CP 1243-8 IRC

and TS module RS232

MODEM MD2

MODEM MD2Industrial Ethernet

Dedicated line

LTOP1
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Table 2-1 

No. Module Explanation 

1.  Central station The central station consists of a PC/PG with integrated 
Ethernet interfaces. The PC is connected to the master 
TIM 4R-IE via one of the Ethernet interfaces. 

TIM 4R-IE uses the serial interface for the connection 
with dedicated line modem MD2. 

2.  Remote station 2 Remote station 2 consists of an S7-1200 station (CPU 
1217C) and a CP 1243-8 IRC.  

The CP uses the serial interface with TS module RS232 
for the connection to dedicated line. 

3.  Remote station 1 Remote station 1 consists of an S7-300 station (CPU 
315-2 PN/DP) and a TIM 3V-IE Advanced.  

 

Note The PC in this example is engineering platform and control center in one. Apart 
from the STEP 7 and WinCC development environment, the WinCC and ST7cc 
Runtime environment with the ST7 connection to the S7 station hence also runs 
here simultaneously. 
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Advantages 

The solution presented here offers the following advantages: 

 Expansion of existing S7-300/400 SINAUT plants with S7-1200 stations via 
CP 1243-8 IRC. 

 Integration of local automation and data transfer. 

Change-controlled process data transfer with the control center and between 
the individual stations. 

 Supplying the archives in the control center system using the provided time 
stamps. 

 Network wide clock synchronization (via the SINAUT networks). 

Advantages of redundancy 

 Increases operational safety. 

 In the event of a failed Ethernet connection (primarily communication path) the 
data transmission is ensured via the dedicated line. 

Delimitation 

This application example does not contain a description of:  

 SIMATIC NET Industrial Remote Communication (see \3\)  

 SIMATIC NET SINAUT ST7 (see \4\) 

 WinCC V7.3 (see \5\) 

 TeleControl CP 1243-8 IRC (see \6\) 

 SIMATIC NET TeleControl SINAUT ST7cc (see \7\) 

Basic knowledge of these topics is assumed. 
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2.2 Description of the core functionality  

Realized functions 

Two parallel pumps that feed into a common pipeline shall be controlled and 
monitored from a central station. In addition, the stations shall exchange process 
data with each other: 

 Cyclic switching of the operating state of the pumps in automatic mode. 

 Automatic switching of a pump (automatic mode), when changing the operating 
state of the second pump (manual mode). 

For cyclic switching, station 2 (S7-1200) becomes the master. 

 

Note For a more detailed description of these functions, please refer to chapter 3 and 
the following chapters. 

 

2.3 Overview and description of the WinCC user interface  

The visualization of the application example is performed with WinCC via the four 
configured screens “Overview”, “Communication”, “Archives”, and “Alarm”. 

“Overview” screen 

The “Overview” screen displays the hardware setup of the application example and 
the connection status of both substations.  

Figure 2-2 

1

2

34

 

Table 2-2 

No. Element Note 

1.  “WinCC Alarm Control” Display of the relevant messages 

2.  Screen change Clicking the buttons navigates to the 
respective screens. 

3.  “Subscribers Status” Connection status of both substations 
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No. Element Note 

4.  “Hardware Overview” Hardware setup of the application 
example 

“Communication” screen 

The “Communication” screen shows the connection status of both substations. 
With this screen, two stations can be controlled and monitored. 

Figure 2-3 

1 2

3
4

5

 

Table 2-3 

No. Element Note 

1.  “Station 1” Connection status of station 1  
(S7-300) 

2.  “Station 2” Connection status of station 2  
(S7-1200) 

3.  Screen change Clicking the buttons navigates to the 
respective screens. 

4.  “Operating Mode /Operating Status” Operating mode and operating status of 
station 2 

5.  “Operating Mode /Operating Status” Operating mode and operating status of 
station 1 
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“Archive” screen 

The process tags are stored in an archive. The “Archives” screen displays stored 
tags of the individual substations. 

Figure 2-4 

1 2

3

4

5

6

 

 

Table 2-4 

No. Element Note 

1.  “WinCC OnlineTableControl” Table with the stored values 
“OperatingMode” and “OperatingStatus” 
of station 1 (S7-300) 

2.  “WinCC OnlineTableControl” Table with the stored values 
“OperatingMode” and “OperatingStatus” 
of station 2 (S7-1200) 

3.  Screen change Clicking the buttons navigates to the 
respective screens. 

4.  “WinCC OnlineTrendControl” Display of the trends of the stored 
values “OperatingMode” and 
“OperatingStatus” of station 1 (S7-300) 

5.  “WinCC OnlineTrendControl” Joint display of the trends of station 1 
and station 2 (S7-1200) 

6.  “WinCC OnlineTrendControl” Display of the trends of the stored 
values “OperatingMode” and 
“OperatingStatus” of station 2 (S7-1200) 
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“Alarm” screen 

The “Alarm” screen displays all relevant messages. 

Figure 2-5 

1 2 3

4

 

Table 2-5 

No. Element Description 

1.  “Date&Time” Time stamp of the message  

2.  Number Message number (for more information, 
please refer to the WinCC Explorer 
Alarm Logging) 

3.  Message text Message description (for more 
information, please refer to the WinCC 
Explorer Alarm Logging) 

4.  Screen change Clicking the buttons navigates to the 
respective screens. 
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2.4 Hardware and software components 

2.4.1 Validity 

This application is valid for 

 STEP 7 V5.5 SP4 

 STEP 7 V13 SP1 Update 4 

 STEP7 V13 SP1 Support Package 0111 for CP 1243-8 IRC 

 SINAUT ENGINEERING SOFTWARE V5.5 

 SINAUT ST7cc V3.1 + SP2 S  

 SIMATIC WinCC 7.3 

 S7-1200 as of V4.1 

 

2.4.2 Components used 

The application was created with the following components: 

Hardware components 

Table 2-6 

Component Qty Article number Note 

CPU 1217C 
DC/DC/DC 

1 6ES7217-1AG40-0XB0 Any S7-1200 CPU as of V4.1 
can be used 

CP 1243-8 IRC 1 6GK7243-8RX30-0XE0  

TS MODULE RS232 1 6ES7972-0MS00-0XA0  

CPU315-2 PN/DP 1 6ES7315-2EH14-0AB0 Any S7-300 CPU can be used 

TIM 3V-IE 
Advanced 

1 6NH7800-3CA00 A TIM 3V-IE can also be used 

TIM 4R-IE 1 6NH7800-4BA00  

SCALANCE 
X204IRT 

1 6GK5204-0BA00-2BA3 Any module can be used. 

MODEM MD2 2 6NH7810-0AA20 Incl. connecting cable 

6NH7700-2AR60 

LTOP1 2 6NH9821-0BB00 Optional 

Only for protection against 
overvoltage in real setup. 

Connecting cable 2 6NH7701-4AL Connection 

TIM...Modem 

PS307 5A 1 6ES7307-1EA00-0AA0 Power supply 

Micro Memory Card 1 6ES7953-8LF11-0AA0 Memory card for the S7-300 
CPU 

SIMATIC memory 
card 

1 6ES7954-8LF01-0AA0 

 
Memory card for the S7-1200 
CPU 
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Software components 

Table 2-7 

Component Qty Article number Note 

SINAUT 
ENGINEERING 
SOFTWARE 
V5.5 

1 6NH7997-0CA55-0AA0  

SINAUT ST7cc 
V3.1 + SP2 S 

1 6NH7997-7CA31-0AA1 License for max. 6 SINAUT 
stations 

STEP 7 V5.5 
SP4 

1 6ES7810-4C.10-…  

SIMATIC 
WinCC 7.3 

1 6AV63.1-….7-0…  

STEP 7 V13 
SP1 

1 6ES7822-1AA03-0YA5  

CP 1243-8 IRC: 

STEP7 V13 
SP1 Support 
Package 0111 

1 https://support.industry.siemens.com/cs/ww/en/view/72341852 

 

Example files and projects  

The following list includes all files and projects that are used in this example. 

 

Table 2-8 

Component Note 

109479747_CP1243-8_DedicatedLine_CODE_V10.zip This zip file includes: 

 STEP 7 V5.5 
project and 
SINAUT ST7 
project 

 STEP 7 V13 
project 

 ST7cc project 

 WinCC project 

109479747_CP1243-8_DedicatedLine_DOC_V10_en.pdf This document. 

https://support.industry.siemens.com/cs/ww/en/view/72341852
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3 Mode of Operation 
Key points of this application example: 

 Configuring an S7-1200 station for expanding the existing S7-300/400 SINAUT 
plants (see chapter 4) 

 Data exchange between an S7-1200 station and an S7-300 station (cross-
communication) and between the stations and the central station. 

3.1 General overview of the program for pump control 

In the application example, the following functions are realized for simulating the 
pump control: 

Table 3-1 

Function Description Note 

 

 

Station 1: automatic mode 

 

Station 2: automatic mode 

 As long as the operating modes of the 
two stations remain unchanged, the 
pumps will switch over automatically at 
30-second intervals. 

 Always one pump at a time is in 
operating state “ON”. The other pump 
is set to “OFF”. 

For cyclic switching, station 2 (S7-1200) 
becomes the master. 

In automatic mode, the 
pumps cannot be operated 
manually. 

Station 1: manual mode  

 

Station 2: automatic mode  

 

or 

 

Station 1: automatic mode 

 

Station 2: manual mode 

The pump of one station needs to first be 
manually switched “ON” / “OFF” in order for 
the pump of the other station to be 
automatically switched “OFF” / “ON”. 

 

When one pump is set to 
“manual” mode, automatic 
switchover at 30-second 
intervals is not possible. 

 

 

Station 1: manual mode  

 

Station 2: manual mode 

 

For the pumps in station 1 and 2 any “ON” 
and “OFF” combination is possible: 

 

Pump of station 1 

ON 

OFF 

ON 

OFF 

Pump of station 2 

ON 

OFF 

OFF 

ON 

 

Both stations exchange this information permanently via cross-communication. 
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Figure 3-1 Simulation of the pump control 

Start Start
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Manual Manual

Both stations 
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Station 1 Station 2

Central station

Ethernet

1

2

3

a

b

4

4

5

Operating mode 
ON<>OFF

3

4

3

ST7cc

WinCC

 

Table 3-2 

No. Station 1 Station 2 

1.  ST7cc Runtime and WinCC have been started. The controller of the stations can be 
started. 

2.  When starting the example system for the first time, the two stations are in 
“automatic” mode, and the pump in station 2 (S7-1200) is set to “ON”.  

 As long as the operating modes of the two stations remain unchanged, the 
pumps will switch over automatically at 30-second intervals. 

 The pump in station 2 (S7-1200) will be set to “OFF” and the pump in station 1 
(S7-300) will be set to “ON”. 

In automatic mode, the pumps cannot be operated manually. 
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No. Station 1 Station 2 

3.  If the pump of station 1 (S7-300) is active and the pump of station 2 (S7-1200) 
turned “ON” / “OFF” manually, the pump of station 1 (S7-300) will be automatically 
switched “OFF” / “ON”. 

4.  If the pump of station 2 (S7-1200) is active and the pump of station 1 (S7-300) 
turned “ON” / “OFF” manually, the pump of station 2 (S7-1200) will be switched 
“OFF” / “ON” automatically. 

5.  Any data is stored in the central station and displayed in WinCC. 

 

Program overview station 1/ station 2 

The program structure for both stations is identical. The figure below shows the 
most important elements. 

Figure 3-2 

Main
Set_p

Pump

DATA

IDB_Set_

Pump

Data 

points

Station 1 > TD7onTIM

Station 2 > CP 1243-8 IRCUser block Data blocks

 

Table 3-3 

Element Symbolic name Description 

OB1 Main Cyclic OB: Calling the user program 

FB2 / FB1 Set_Pump FB “Set_Pump” contains the described functions 
(chapter 3.1) fully implemented already. 

DB2 IDB_Set_Pump Instance data block of the user block 

DB1 Data Global data block for saving the data 

Data points Configured data points for the data exchange 
between both stations or between a station and 
the central station (see Table 4-5 and Table 4-9) 
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Global data block “Data” (DB1) 

DB “Data” contains send data and receive data to/from the partner station. The 
structure of the global data block is identical for both stations. 

Figure 3-3 Station 1_Global_data_block  

 

 

Figure 3-4 Station 2_Global_data_block  
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Table 3-4 

Name Data type Description 

OperatingStatus INT Operating state of the station 

“1”: switched off 

“2”: switched on 

This tag is not a monitoring tag. It is only used by 
FB “Set_Pump”.  

OperatingMode BOOL Operating mode of the station 

False: automatic 

True : manual 

PartnerOpStatus INT Operating state of the partner station 

“1”: switched off 

“2”: switched on 

This tag is not a monitoring tag. It is only used by 
user block FB “Set_Pump”. 

PartnerOpMode BOOL Operating mode of the partner station 

False: automatic 

True : manual 

partnerStatus BOOL Operating state of the partner station 

False: automatic 

True : manual 

This tag is only relevant for station 2; it is not a 
monitoring tag. It is only used by FB “Set_Pump”. 

TimerOB1 TIME  

 

 

These tags are used for calling FB “Set_Pump” in 
OB1 

OperatingModeOB1 BOOL 

OperatingStatusOB1 BOOL 

DoneOB1 BOOL 

BusyOB1 BOOL 

ErrorOB1 BOOL 

StatusOB1 DWORD 
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3.2 Functionality of station 1 (S7-300) 

3.2.1 Program details for FB “Set_Pump” (FB2) 

The following figure and table show the call interface of user block FB “Set_Pump” 
(FB2). 

Figure 3-5 

InOut

Output

 

 

Table 3-5 

Name Data type Description 

operatingMode BOOL Operating mode of the station 

False: automatic 

True : manual 

operatingStatus BOOL Operating state of the station 

False: off 

True : on 

done BOOL Indicates whether job processing was 
performed without any errors. 

Only pending for one CPU cycle. 

busy BOOL Displayed job processing for the block 

True: block active 

False: block passive 

error BOOL An error has occurred while processing the 
block. 

Only pending for one CPU cycle. 

status DWORD Display of error number.  

Only pending for one CPU cycle. 
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3.2.2 Calling FB “Set_Pump” (FB2) in OB1 

FB “Set_Pump” (FB2) is called cyclically in OB1. The figure below shows the call. 
The input and output parameters are stored in global data block “Data”. 

Figure 3-6 
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3.3 Functionality of station 2 (S7-1200) 

3.2.1 Program details for FB “Set_Pump” (FB1) 

The following figure and table show the call interface of user block FB “Set_Pump” 
(FB1). 

Figure 3-7 

Input

InOut

Output

 

 

 

Table 3-6 

Name Data type Description 

timer TIME Time interval for automatic switchover of 
the operating status of the stations 

operatingMode BOOL Operating mode of the station 

False: automatic 

True : manual 

operatingStatus BOOL Operating state of the station 

False: off 

True : on 

done BOOL Indicates whether job processing was 
performed without any errors. 

Only pending for one CPU cycle. 

busy BOOL Displayed job processing for the block 

True: block active 

False: block passive 

error BOOL An error has occurred while processing 
the block. 

Only pending for one CPU cycle. 

status DWORD Display of error number.  

Only pending for one CPU cycle. 
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3.3.1 Calling FB “Set_Pump” (FB1) in OB1 

FB “Set_Pump” (FB1) is called cyclically in OB1. The figure below shows the call. 
The input and output parameters are stored in global data block “Data”. 

Figure 3-8 

 

 

3.4 Error and status display 

For error diagnostics, the FB “Set_Pump” function block has a STATUS output. 

The following table shows the error messages of the function block.  

Table 3-7 

STATUS Description Remedy 

16#00008101 There is no connection to the 
partner station. 

Check the connection between both 
stations. 

16#00008102 There is no connection to the 
central station. 

 Check the connection between 
the station and the central 
station. 

 Start ST7cc Runtime. 

16#00008103 There is no connection to 
partner station and central 
station. 

 Check the connection between 
both stations and between the 
stations and the central station. 

 Start ST7cc Runtime. 
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4 Configuration and Settings  

4.1 Overview 

Note The configuration and settings are ready implemented in the project. This 
chapter is for information purposes only. 

Since SINAUT ST7 is currently not yet completely supported in TIA Portal, the 
following two engineering tools are required for configuring CP 1243-8 IRC: 

 STEP 7 V5.5 and SINAUT engineering software V5.5 and  

 STEP7 V13 SP1 Support Package 0111. 

Perform the configuration successively in the following configuration tools. 

 

Note Handling the configuration tools is not discussed in this documentation. Basic 
knowledge of these tools is assumed. 

 

Figure 4-1 

STEP 7 V5.5

• Configuring the S7-300 station

• Configuring a CP proxy (PROXY CP 

1243-8 IRC) for the S7-1200 station

• Configuring the central station (St7cc)

• Configuring the dedicated line

SINAUT ST7 Engineering Tool

• Configuring the SINAUT connections

• Configuring the subscriber 

administration

• Exporting the configuration data for CP 

1243-8 IRC

STEP 7 V13

• Configuring the S7-1200 station

• Importing the configuration data (of 

SINAUT ST7) for CP 1243-8 IRC

• Create data points

SINAUT ST7cc

• Integrating ST7cc into SINAUT network

• Create ST7cc project

• Configuring the data with ST7cc Config

• Generating the WinCC configuration for 

ST7cc tags and their processing
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4.2 Configuration in STEP 7 V5.5 

In STEP 7 V5.5, all of the stations as well as the S7 connections are configured. In 
addition, a proxy for the CP (PROXY CP1243-8 IRC) is configured in an S7-300 
station. 

4.2.1 Configuring the stations 

Table 4-1 

No. Action 

1.  In the SIMATIC Manager, you create a STEP 7 project and add an S7-300 
station. 

2.  Open HW Config and add any S7-300 controller with TIM 3V-IE Advanced. 

3.  Add any second S7-300 station.  

4.  In the second station, you enter the 
“proxy” as a representative for the CP. 

You find the module in the catalog of HW 
Config under the name 

"PROXY CP1243-8 IRC". 

Configure the proxy like  
TIM 3V-IE Advanced. 

 

5.  In the SIMATIC Manager you enter a SIMATIC PC station. 

6.  Specify the hardware configuration of the PC station: 

Slot 1: Application 

Slot 4: CP Industrial Ethernet (IE General). 

7.  Add a master TIM 4R-IE to your network configuration. 

8.  Open NetPro. Add two new Ethernet networks and assign the desired IP 
addresses to the modules. 

Central station TIM 4R-IE

S7-300 with TIM 3V-IE Proxy for

CP 1243-8 IRC  
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4.2.2 Configuring of the dedicated line 

To prevent data loss in the event of a failed Ethernet connection (primary 
communication) between the stations, the dedicated line is configured as 
secondary communication. 

Table 4-2 

No. Action 

1.  Open NetPro and add a new dedicated line by double clicking on “SINAUT 
Dedicated line” in Subnets. 

 

2.  Double click on the newly created dedicated line to open the Properties dialog for 
this dedicated line. 

3.  Set the baud rate to 19200 bps for this application example. 

 

4.  Click OK to confirm your settings. 

5.  Open the Properties of TIM 4R-IE by double clicking on the TIM, and go to the 
Interfaces tab. 
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No. Action 

6.  Select the interface WAN 1. 

7.  Click on “New” to create the network node, then click on the “Properties” button 
to specify the parameters. 

8.  Select the dedicated line you have created beforehand. 

9.  Select “Master” in the node type field and click on OK to confirm your settings. 

 

10.  Select the MD2 modem, then click on OK to close this dialog. 
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No. Action 

11.  Repeat this procedure for PROXY CP1243-8 IRC (as of step 5). In step 9, you 
define station 2 as Station. 

 

12.  Subsequently, you save and compile the project in NetPro to enable access to 
the configured data from the other STEP 7 and SINAUT applications. 

 

Note The time of day synchronization for each station must be configured in STEP 7 
V5.5. 

 

Note The physical settings of the modem are set via DIL switch at the module (see 
chapter 5.1.1). These settings need to match the configuration in NETPRO. 

A detailed description of the DIL switch is available in /9/. 
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4.3 Configuration with the SINAUT ST7 configuration tool 

The SINAUT ST7 configuration software represents the user interface for the 
configuration of SINAUT telecontrol systems. Using this software helps the user 
install and configure the telecontrol components into a STEP 7 project. 

Apart from this, the SINAUT ST7 software makes the following configuration 
possible 

 SINAUT networks and WAN network nodes, 

 SINAUT TIM modules and 

 SINAUT connections. 

Before starting with the configuration, you need to import the PC station (see 
chapter 5.4.1). 

4.3.1 Configuration of the SINAUT connections 

Table 4-3 

No. Action 

13.  Start the SINAUT ST7 configuration tool. 

“Start > Siemens automation > SIMATIC > SINAUT ST7 > Configuration” 

14.  Open the STEP 7 project created in chapter 4.2. 

 
15.  Select Connection Configuration and click on the OK button to start. 
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No. Action 

16.  All possible connections are listed in the right-hand window pane. Select the 
desired connections via right mouse button -> “Add”: 

 
 

 

 Connection to the SINAUT ST7cc control center (Ethernet and dedicated 
line). 

 Connection between both stations (Ethernet and dedicated line). 

Adopt only the desired connections. 

17.  Save the configuration. 

Save the configuration in NetPro again. 

18.  Go to “Subscriber Administration”. 
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4.3.2 Configuration of the TIMs with TD7onTIM 

The SINAUT communication of CPU modules with each other, or of CPU modules 
with a control center is realized with the help of TIM modules. The organization of 

the SINAUT communication is handled by the SINAUT TD7 software package. In 

SINAUT station S7-300, the TD7 software is configured on the TIM. 

 

Note This configuration is not required for the proxy module of CP 1243-8 IRC. The 
configuration data for CP 1243-8 IRC is imported into STEP 7 V13 via a text file 
(see chapter 4.4). 

 

Table 4-4 

No. Action 

1.  All SINAUT subscribers (CPUs, TIMs, CP 1243-8 IRC, SINAUT ST7cc PC) are 
listed. 

You can enter any not yet assigned subscriber number according to your desires. 

.  

2.  In Subscriber Administration, the TD7onTIM stations are configured. Select the 
TIM 3V-IE.

 

3.  Click on the TD7onTIM library icon. 

 
A window with the TD7onTIM Library opens. 

Select the object you wish to configure (Bin08X_R) and click on “Paste into 
Project”. 
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No. Action 

 
Click the Close button to close the library. 

4.  Define the parameters for the objects. 

 
 

If you select the DB as memory area, you need to create a data block with the 
required tags in the S7-300 CPU. 

5.  Select the communication partner for the respective data object. 

 
Note: 

All partners must be added to the “Selected partners” list from which the data of 
the object shall be received or sent to. If no partner is adopted in the “Selected 
partners” list, the object will not be processed. 
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No. Action 

6.  Enter your own source object number and the partner object number.  

 
 

The configuration tool specifies a value with continuous numbering that can be 
changed. Inconsistent double assignment of numbers is blocked. 

 

Note: 

In these input fields, the data object is assigned to the respective partner object 
of the selected communication partner. 

For objects from/to ST7CC/SC, the partner object number is always 0. 

7.  Then save and compile your project. 

8.  Confirm the security prompt with OK, leave the options settings unchanged and 
click the OK button. 

 

9.  The SDBs are generated anew and saved in the STEP 7 project. 

 
If no errors have occurred, close the program again. 

10.  Load the configuration into the TIM 3V-IE: 

 Open the SIMATIC Manager 

 Select the “Blocks” folder TIM-3V-IE of the S7-300 station 

 Load the system data into the TIM 3V-IE. 

Then load the S7-300 station. 
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Configured SINAUT objects  

The transmission and receipt of process data is configured with the help of 
standardized data objects. The following table describes the SINAUT objects 
configured for this example. 

Table 4-5 

Object object 
number 

Partner 

Object 

 

Explanation 

Bin08X_S 1 1_ Bin08X_R Sending the operating mode to S7-1200 

Ana04W_R 2 3_ Ana04W_S Receiving partner operating status 

Ana04W_S 3 4_Ana04W_R Sending operating status to S7-1200 

Cmd01B_R 4 0_Cmd01B_R Receiving command from the ST7cc 

Bin04B_S 5 0_ Bin04B_S Sending the operating mode to St7cc 

Bin08X_R 6 2_Bin08X_S Receiving partner operating mode 

Bin08X_S 7 7_Bin08X_R Sending operating status to S7-1200 

 

4.3.3 Exporting configuration data 

After completing the configuration of the proxy in STEP 7 V5.5 and in the SINAUT 
configuration tool, the specific configuration data for the telecontrol communication 
of the proxy as well as for the TIM modules is stored in the system blocks (SDBs). 

Table 4-6 

No. Action 

1.  In the SINAUT ST7 configuration tool you open the SINAUT diagnostics and 
service tool. 

 

2.  Select the proxy. 
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No. Action 

3.  Right click to open the “SINAUT > SDB viewer” menu. 

 

4.  Save the file. 

 
Close the dialog. 
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4.4 Configuring in STEP 7 V13 

In STEP 7 V13, the S7-1200 station is configured: 

 import the configuration data 

 configuring the data points of the CP 1243-8 IRC. 

Prerequisite for the complete configuration of the CP in STEP 7 V13 is the 
configuration in STEP 7 V5.5 (see chapter 4.2) and the configuration with the 
SINAUT ST7 configuration tool (see chapter 4.3) 

4.4.1 Configuring the parameters of CP 1243-8 IRC 

Table 4-7 

No. Action 

1.  Create a STEP 7 V13 project. 

2.  Add the S7-1200 CPU (as of V4.1) for the SIMATIC station. 

3.  Add the CP 1243-8 into the station. 

 

4.  Create an Ethernet network and connect the CP to the Ethernet network. 

 

5.  Enable the telecontrol and S7 communication: 

“Properties > Communication types” 
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No. Action 

6.  For the CP, you import the configuration data from the  

STEP 7 V5 project via the text file: 

 In your STEP 7 V13 project you select CP 1243-8 IRC. 

 Select the parameter group “Partner stations”. 

 

 Click on the “Import partner configuration” button. 

 

 From the file system of the engineering station, you select the text file you 
exported from the CP proxy of the SINAUT ST7  
project (see chapter 4.3.3). 

7.  Enable the security functions.  

 

Create a user for the security functions. 

“Properties > Security > Security properties” 

8.  Load the project data into the station.  

 

Note: 

When loading the station, the project data of the station is stored on the CPU, 
including the configuration data of the CP. 
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4.4.2 Configuring the data points of CP 1243-8 IRC 

The transmission of user data between the S7-1200 CPU and your communication 
partner does not require the programming of program blocks for the CP. The data 
areas in the memory of the CPU intended for the communication with the partner, 
are configured data-point-related in the CP. Any data point is linked to a PLC tag or 
a data block in the CPU here. 

Table 4-8 

No. Action 

1.  In the CPU, you create a data block with the required PLC tags for the data points. 

 

2.  In STEP 7 you open the editor for data point configuration and message 
configuration ST7_S7_1200 > PLC_1 > Local modules > CP 1243-8 IRC. 

 

3.  Create the data points of the CP. 

 

4.  For each data type you select the transmission type. 

 

“Transfer after call” 

The respective most current value of the data point is only entered into the picture 
memory of the CP. New values of a data point overwrite the last saved value in the 
picture memory. 
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No. Action 

“Every value triggered” 

The data point is configured as event. 

Each value change is entered into the send buffer in chronological order. 

 

“Current value triggered”: 

The data point is configured as event. 

Only the respectively last current value is entered into the send buffer. There, it 
overwrites the previously stored value. 

5.  For each data type you configure the trigger conditions. 

 

6.  Assign the data object to the respective partner object. 

 

7.  Select the communication partner for the respective data object. 

 

8.  Save and load the changes. 

 

Configured data types 

Table 4-9 

Object object 
number 

Partner 

Object 

 

Explanation 

Bin08X_R 1 1_Bin08X_S Receiving the partner operating mode 

Bin08X_S 2 6_Bin08X_R Sending the operating mode to S7-300 

Ana04W_S 3 2_Ana04W_R Sending the operating status to S7-300 

Ana04W_R 4 3_ Ana04W_S Receiving partner operating status 

Cmd01B_R 5 0_ Cmd01B_R Receiving a command from the ST7cc 

Bin04B_S 6 6_Bin04B_S Sending the operating status to St7cc 

Bin04B_S 6 6_Bin04B_S Sending the operating mode to St7cc 

Bin08X_R 7 7_Bin08X_S Receiving the status of the S7-1200 
station  
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4.5 Configuration of ST7cc  

SINAUT ST7cc is the ideal control center system for SINAUT ST7 based on 
SIMATIC WinCC. It is specifically adjusted to the event-controlled and 
time-stamped data transmission of the SINAUT system. 

In combination with the WinCC redundancy package, a highly available ST7cc 
control center can be realized. 

SINAUT ST7cc provides the following benefits to the user: 

 Connecting SINAUT stations to SIMATIC WinCC via classic, serial WAN or via 
Ethernet-based WAN 

 Entering messages, analog values, and count values into WinCC archives 
using the event times supplied by the SINAUT stations 

 Time saving and cost reduction due to simple configuration without detailed 
knowledge of SINAUT 

The table below lists the steps necessary for configuring the St7cc. 

Table 4-10 

No. Action 

1.  Open the SINAUT ST7cc Config. 

2.  Add a local TIM for the St7cc PC. 

“Edit > New local TIM” 

 
Enter the SINAUT subscriber number of the TIM. 

3.  Add the stations with their subscriber number. 

“Edit > New Station” 

 

4.  Add the desired objects by copying them from the library. Configure the objects 
as desired. 

 

5.  Open the global settings. 
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No. Action 

 “Edit > Global Settings”. 

 
 

In the “Computer” tab, you enter the name and IP address of the ST7cc PC, and 
enter the server settings in System. 

 

6.  Go to the “Project” tab and activate it for the St7cc Runtime. 
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No. Action 

7.  Open the project settings mask. 

 “Edit > Project Settings”. 

 
Go to the “Communication” tab. 

 

Enter the subscriber number of the ST7cc PC. 

Then, click on “New” and enter the subscriber number of the local TIM and the 
local ID for the connection between TIM and ST7cc PC. 

 

 
Click on OK to confirm the settings. 

 

 

Note: 

The local ID is available in NetPro. Click on the PC-Station and then on 
Application. The ID is displayed in the bottom window. 

 
 

The access point must be created in the PG/PG station settings and assigned to 
the Ethernet adapter used: 

> "Adaptername".TCP. 
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No. Action 

8.  Save the ST7cc project. 

 

Configured ST7cc objects 

Table 4-11 

Object object 

number 

Partner Explanation 

Cmd01B_R 4 Station 1 
(subscriber 2) 

Setting/ resetting OperatingMode 
and OperatingStatus of station 1 

Bin04B_S 5 Station 1 

(Subscriber 2) 

Receiving OperatingMode and 
OperatingStatus of station 1 

Cmd01B_R 5 Station 2 

(Subscriber 3) 

Setting/ resetting OperatingMode 
and OperatingStatus of station 2 

 

Bin04B_S 6 Station 2 

(Subscriber 3) 

Receiving OperatingMode and 
OperatingStatus of station 2 
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4.6 WinCC generation 

The parameters of processes executed in WinCC are transferred to the WinCC 
target component via the ODK interface. St7cc Config supports the following 
generation options: 

 WinCC generation: 

– WinCC tag management 

– WinCC messages 

– WinCC archive tags 

 Generating the subscriber picture typicals. 

Requirements for the generation 

Prior to generating tags, messages, or archives, please ensure that the following 
requirements have been met: 

 The project in which you wish to generate is set as current WinCC project in 
configuration mode (must not be in runtime mode). 

 The standard language of the project is activated. 

 The channel DLL for the ST7 server (ST7.DLL) is declared in the project. 

 The messages classes and messages types for system tags and user tags are 
created in WinCC. 

 The user archives are created in WinCC. 

At the first generation sequence, St7cc Config logs in at all WinCC components. 
Logout is only performed when closing the generation dialog. 

 

Note More information on working with WinCC is available in manual “WinCC 7.3: 
Working with WinCC” (see \8\) 

 

WinCC generation 

The following table shows how all of the required configuration data of ST7cc is 
transferred in WinCC. 

Table 4-12 

No. Action 

1.  Open the SINAUT ST7cc Config. 

2.  Open your ST7cc project (see Table 4-10). 

3.  Insert the picture typicals and the faceplates into process pictures: 

“Admin > Copy Faceplates to WinCC Project > WinCC Project > open .mcp data”. 
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No. Action 

4.  Insert the subscriber picture typicals into 
a process picture: 

“EDIT > create the Project picture-
typicals”. 

 

5.  Insert the technical picture typicals into 
a process picture: 

“Edit > create the technical picture-
typicals”. 
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5 Installation and Commissioning 
This chapter contains all steps necessary for commissioning the example with the 
code from the download and the hardware list. 

5.1 Installing the hardware 

For the necessary hardware components, please refer to chapter 2.4. 

Note Always follow the installation guidelines for all components. 

 

NOTICE Before switching on the power supply, you need to complete and check the 
installation! 

Hardware setup 

The figure below shows the hardware configuration of the application. 

Figure 5-1 

TIM 4R-IE

Engineering-Station

CPU                TIM 3V-IE

315-2 PN/DP  Advanced

24V
24V

24V

24V

CP 

1243-8 IRC

SCALANCE 

X204IRT

Port X4

Port X3

TS 

Module 

RS232

CPU 

1217C

24V

24V

MODEM 

MD2

MODEM 

MD2

LTOP1
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The following table contains the overview of all IP addresses and SINAUT 
subscriber numbers used in this example. The fixed assignment of the IP 
addresses is assumed. 

In all network components, the subnet mask is 255.255.255.0. 

Table 5-1 

Component IP address SINAUT subscriber 
number 

Description 

ST7cc computer 192.168.1.100 1 Central station 

TIM 4R-IE 192.168.1.10  

1003 

 

Master TIM, 
Ethernet Port X4 

TIM 4R-IE 192.168.0.10 Master TIM, 
Ethernet Port X3 

TIM 3V-IE 
Advanced 

192.168.0.4 1002 TIM in station 1 

CP 1243-8 IRC 192.168.0.3 1001 CP in station 2 

CPU315-2 PN/DP 192.168.0.2 2 Station 1 

CPU1217C (proxy 
CPU317-2 PN/DP) 

192.168.0.1 3 Station 2 

 

Note The interfaces X3/X4 of TIM4R-IE need to be located in different subnets. 

 

5.1.1 Settings for the MD2 modems 

To establish a connection via dedicated line, the modem network settings need to 
be defined by setting the DIL switches of both modems accordingly. 

DIL switches that can be accessed from above 

Table 5-2 

No. Action Notes 

1.  Turn the DIL switches of both 
modems upwards to ON position 
(delivery state). 

  

2.  Then set the 5-pin DIL switch as 
follows: 

 switch 2: down (ON) = 2-wire 
operation 

 switches 4 + 5: down (ON) = 
baud rate 19200 bps. 

 

The 10-pin DIL switch remains in its 
delivery-state position for both modems; 
that is, all switches are in an upward 
position (OFF). 

 

 

 

   2-wire mode Baud rate 19200bit/s 
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DIL switches that can be accessed from below 

Table 5-3 

No. Action Notes 

1.  There are two DIL switches at the 
bottom of the MD2 modem. 

Set the 4-pin DIL switch of the 
modems on RS232 interface active 
(see Figure 5-2). 
 

 

2.  Set the 4-pin DIL switch for connection 
of the WAN-side terminating resistors 
as follows: 

 Switch 1: up (OFF) 

 switch 2: down (ON) 

 Switch 3: up (OFF) 

 Switch 4: down (ON) 

 

Terminal point for 2-wire or 2 x 2-wire 
operation; 

transmission rate: 9600 or 19200 bps 

 

Figure 5-2 DIL switches that can be accessed from below 

Front door with caption of modem

WAN connection for modem 

MD2. The connectable standard 

cable connection is supplied with 

the MD2 delivery.

4-pin DIL switch for connecting 

the WAN-side terminating 

resistors.

This 4-pin DIL switch defines 

whether the RS232 or the RS485 

interface shall be active.

Below, the standard settings for 

RS232 and  RS485:

RS232 interface active

RS485 interface active
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5.1.2 Installing the hardware 

For setting up the hardware, please proceed according to the following table: 

Table 5-4 

No. Action Notes 

1.  Connect engineering station  Connect computer to port X4 of TIM 
4R-IE 

2.  Mount the voltage supply  Connect the PS307 to the power 
grid (220 / 230 V AC). 

The SIMATIC PS307 can supply all the 
modules required here. 

3.  Install TIM 4R-IE  Connect the power supply 

 Connect computer to port X4 of TIM 
4R-IE 

4.  Modem MD2 (first modem)  Connect the power supply 

 Connect the first modem MD2 
(connecting cable 6NH7701-4AL) 
with the TIM 4R-IE via the serial 
interface (WAN 1). 

 Insert the RJ12 cable connector of 
the 6NH7700-2AR60 connecting 
cable into RJ socket X3 of the 
modem, and insert the other cable 
connector of the cable into the 
socket on the first LTOP. 

 Connect the 2 cores of the 
dedicated line cable between the 
LTOPs to terminal 1+2 respectively 
on the LTOP. 

Each DIP switch of LTOP1 must be 
set to position "1". 

5.  Modem MD2 (second modem)  Connect the power supply 

 Connect the second modem MD2 
(connecting cable 6NH7701-4AL) 
with TS module RS232 of station 2 
(S7-1200) 

 Insert the RJ12 cable connector of 
the 6NH7700-2AR60 connecting 
cable into RJ socket X3 of the 
modem, and insert the other cable 
connector of the cable into the 
socket on the second LTOP. 

6.  Install CPU315-2 PN/DP  Adjust backplane bus adapter for 
TIM 

 Connect the power supply 

 Plug the MMC 

7.  Install TIM 3V-IE Advanced  Connect the power supply 

 Connect TIM and CPU315-2 
PN/DP via backplane bus 
connector 

8.  Install CPU 1217C DC/DC/DC  Connect the power supply 

 Plug in the MC 
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No. Action Notes 

9.  Install CP 1243-8 IRC  Connect CP and CPU 1217C (links 
of the CPU) 

 Connect the external power supply 

10.  Install SCALANCE X204IRT  Connect the power supply 

 Connect port 1 to port X3 of the 
TIM4R-IE 

 Connect port 2 with the TIM3V-IE 
Advanced of station 1 

 Connect port 3 with the CP 1243-8 
IRC of station 2. 

 

Note For the CP, only a slot on the left, next to the CPU is permitted. Only a single CP 
1243-8 IRC can be plugged. 

 

Note You need to connect the external power supply of the CP 1243-8 IRC since a TS 
module is used at the CP. 

 

5.2 Installing the software  

When generating the application, one computer was used as the programming PC 
as well as central station. When using separate computers, then the following 
software must be installed on the central station: 

 SINAUT ST7cc V3.1 + SP2 

 SIMATIC WinCC Runtime V7.3 

 SIMATIC NET PC Software Edition 2006 

Table 5-5 

No. Action  Notes 

1.  Install STEP 7 V5.5 + SP4  

 

 

 

Follow the instructions of the installation 
program. 

2.  Install STEP 7 Basic  
V13 + SP1, Update 4 

3.  Install HSP0111 CP 1243-8 IRC 

4.  Install SIMATIC WinCC 7.3 

5.  Install SINAUT ST7 V5.5 

6.  Install SINAUT ST7cc V3.1 + SP2 

7.  Install SIMATIC NET V13 + SP1 
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5.3 Installation of the application software 

Unzip the file “109479747_CP1243-8_DedicatedLine_CODE_V10.zip”. This folder 
contains:  

 the archived STEP 7 V5.5 project  
“109479747_CP1243-8_DedicatedLine_V55_V10.zip” 

 the archived STEP 7 V13 project 
“109479747_CP1243-8_DedicatedLine_V13_V10.zip” 

 the archived ST7cc project “109479747_CP1243-8_ST7cc.zip” 

 the archived WinCC project “109479747_CP1243-8_WinCC_Project.zip”. 

Unzip all of the above mentioned projects.  

 

5.4 Commissioning 

5.4.1 First commissioning of the engineering station 

Assigning the IP address of the PC/PG 

The table below shows the network setting to which you have to change the 
PC/PG: 

Table 5-6 

No. Action 

1.  Open the Internet Protocol (TCP/IP) Properties by selecting 

“Start > Settings > Network Connections > Local Connections”. 

 

2.  In the open window, select “Internet Protocol (TCP/IP)” and open “Properties”. 

3.  Select the option box “Use 
following IP address”, and fill in 
the box as shown in the screen 
shot. Close the dialog boxes with 
“OK”. 

 

 

 

 

 

Note: 

This IP address must match the 
IP address configured in Netpro. 

 

4.  If your PG has an IWLAN interface, switch it off. 
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Importing a PC station 

A “PC station” is a PC with communication modules and software components 
within an automation solution with SIMATIC. 

The hardware configuration of a PC station in SIMATIC is comparable with that of 
an S7 station. Components of a PC station such as modules or software interfaces 
are assigned to a virtual slot and parameterized in the same way. 

Table 5-7 

No. Action 

1.  Open the Component Configurator. 

“Start > all Programs > Siemens Automation > Station Configurator” 

2.  Import the XDB file via the “Import Station” button 

D:\ Projects\ST7_S7_1200\ XDBs\ pcst_1.xdb. (The file is available in your V5.5 
project folder) 

  

3.  Execute the import with “OK”. The components are restarted. 

 
 

Note 

Should the components not be started immediately without error, please reboot 
the PC. 

 

Note The import is only possible if the imported configuration corresponds with the 
locally existing configuration. 
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Specifying access points 

After the configuration of the PC station, the access point of the ST7cc PC in the 
network is defined. 

Table 5-8 

No. Action 

1.  Open the SIMATIC NET 
“Communication Settings”. 

 

2.  Click on “Access Points” in the directory tree on the left. 

 
The available access points are displayed in the right-hand window pane. 

3.  Open the access point “CP_H1_1” and select the setting of the used interface 
from the drop-down list “Associated interface parameter assignment TCPIP”.  
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No. Action 

 
Clicking on “Apply” and “OK” closes the dialog. 

 

5.4.2 Loading the TIM 4R-IE into the central station 

Table 5-9 

No. Action 

1.  Open the STEP 7 V5.5 project  “ST7_S7_1200” 

2.  In the “PLC” menu, select the 
“Edit Ethernet Node” option. 
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No. Action 

3.  Click on the “Browse…” button. 

 

4.  Select the TIM 4R-IE module 
and acknowledge the selection 
with the “OK” button. 

 

In the “Set IP configurations” 
window which appears you 
enter the following details: 

IP address: 192.168.1.10 

Subnet mask: 255.255.255.0 

 

Click on the “Assign IP 
Configuration” button. 

 

Close the dialog. 

 

5.  Mark the “Master TIM” station in the SIMATIC Manager. 

In the “PLC” menu you select the “Download” option. 

 

 

5.4.3 Download of station 1 (S7-300 and TIM 3V-IE) 

Table 5-10 

No. Action 

1.  Open the internet protocol (TCP/IP) properties  

Activate the checkbox “Use following IP-address” and enter the following address: 

IP address: 192.168.0.100 

Subnet mask: 255.255.255.0 

Close the dialog boxes with “OK”. 



5 Installation and Commissioning 

5.4 Commissioning 
 

SINAUT ST7 with CP 1243-8 IRC 
Entry ID: 109479747,    V1.0,    10/2015   57 
 


 S

ie
m

e
n

s
 A

G
 F

e
h

le
r!

 T
e

x
tm

a
rk

e
 n

ic
h

t 
d

e
fi

n
ie

rt
. 

A
ll 

ri
g
h

ts
 r

e
s
e

rv
e
d
 

No. Action 

2.  In the “PLC” menu, select the 
“Edit Ethernet Node” option. 

 

3.  Click on the “Browse…” button. 

 

4.  Select the S7-300 CPU and acknowledge the selection with the “OK” button. 

 

In the “Set IP configurations” window which appears you enter the following 
details: 

 

IP address: 192.168.0.2 

Subnet mask: 255.255.255.0 

 

Click on the “Assign IP Configuration” button. 

 

Close the dialog. 

5.  In the SIMATIC Manager you 
select the station “01_Station”. 

In the “PLC” menu you select 
the “Download” option. 
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5.4.4 Download of station 2 (S7-1200 and CP 1243-8 IRC) 

Table 5-11 

No. Action 

1.  Open the STEP 7 V13 project “ST7_S7_1200”. 

2.  Enable the security functions of the CP 

 

ST7_S7_1200 > Global security settings > user login 

 
User name: administrator 

Password: administrator 

3.  Select station “PLC_1 [CPU1217C DC/DC/DC]”. 

 

4.  Download the project into the station. 
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5.4.5 Display of the communication states of CP 1243-8 IRC 

The LEDs show the communication status of the module according to the following 
scheme. 

Table 5-12 

DIAG CONNECT 
ETH 

CONNECT 

RS232 

Meaning 

 
  

Configuration of the telecontrol 
communication via both interfaces 
without errors and activated.  

No connection established. 

   

Configuration of the telecontrol 
communication via both interfaces 
without errors and activated. 

At least one connection established via 
Ethernet.  

Connection to all partners established via 
the serial interface, or respectively, all 
partners accessible. 

   

Configuration of the telecontrol 
communication via both interfaces 
without errors and activated.  

Connection to all partners established via 
Ethernet.  

At least one connection established via 
the serial interface. 

   

Configuration of the telecontrol 
communication via both interfaces 
without errors and activated.  

All connections established or partner 
accessible. 
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5.4.6 Activating the ST7cc and starting ST7cc and WinCC Runtime 

Adjusting the computer settings in the WinCC project  

 

Note The setting of the computer name in WinCC and in Windows must be identical. 
For this reason, the server name in the System Properties of the WinCC project 
must be adjusted. 

There is also the option to adjust the server name in Windows. 

Table 5-13 

No. Action 

1.  Start the WinCC Explorer and open the project “WinCC_Project.MCP”. 

You find this project in folder “WinCC_Project”. 

2.  Open the System Properties. 

 

3.  In the “General” tab, you adapt the computer name. 

 

4. In the “Startup” tab you activate “Tag Logging Runtime”, “Alarm Logging 
“Runtime”, and “Graphics Runtime”. 
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Activate the ST7cc project 

Table 5-14 

No. Action 

1.  Start St7cc Config via  

“Start > Siemens automation > SIMATIC > ST7cc >ST7cc Config” 

and open the ST7_PROJECT.XML project. 

You find this project in folder “St7cc”. 

 

Note 

When opening a new project, all paths need to be updated: 

“Project > Edit > Project settings > File Paths”. 

 

2.  Open the global settings. 

In the “Computer” tab, you adjust the computer name. 

 
Enter the server settings in System. 
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No. Action 

3.  In the “Project” you activate the current project for ST7cc Runtime. 

 
Close the dialog with “OK”. 

4.  Save the settings. 
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Start ST7cc and WinCC Runtime 

Table 5-15 

No. Action 

1.  Start ST7cc Runtime via 

“Start > Siemens automation > SIMATIC > ST7cc > ST7cc-Runtime”. 

2.  The DOS output window opens and displays information on which programs are 
successively started by ST7cc. 

 
 

Note: 

The window must not be closed manually. 

3.  The Log window of the SINAUT server opens. Amongst other things, it also 
shows the connections with the SINAUT subscribers and the fact that the general 
queries for these subscribers, automatically started at system start, were 
terminated without error. 

 
 

ST7cc server running. 
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No. Action 

4.  In the WinCC Explorer you start WinCC Runtime. 

 

5.  Your ST7 demo plant is now ready for operation. 

 

 

Note If the time in a station is not valid (Clock indicator: “red”), you need to start a 
general request again. 

In the “Overview” screen you click on the corresponding buttons. The Details 
view opens. Start a new general request. 
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6 Operating the Application 
In the following chapters, we will introduce the operation of the demo-project as 
well as the test and diagnostic functions provided by the used components: 

6.1 Overview and description of the user interface  

Figure 6-1 

Overview

Communication

Alarm

Archive
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6.1.1 “Overview” screen 

The “Overview” screen shows all relevant messages, the hardware setup of the 
application example, and the status of all subscribers. 

Subscriber Status 

Table 6-1 

Screen  Description 

 

On this screen, the status of: 

 the control center 

 the local TIM 

 both substations  

can be viewed. 

 

You can open a details list by moving the left 
mouse-button over the respective image. 

 

These faceplates are generated by SINAUT 
depending on the configuration and can be 
easily included into a project. 

 

 
 

Details view 

 

Control center: 

Apart from the existing ST7cc server and the 
directly connected TIMs, the status of the TCO 
(communication module of the ST7cc software) 
is also displayed. 
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Screen  Description 

 
 

Details view 

 

Local TIM: 

The picture typical indicates, whether: 

 the TIM is accessible (subscriber) 

 the last general request to the TIM was 
completed without error (GR), and 

 the time on the TIM is ok (Clock). 

 

In the details view, you can trigger a general 
request to the TIM manually (General request), 
which will then transfer your latest accountancy 
information. The processing of the general 
request can be followed on the GR display as 
well as in text field GR in the faceplate. 

 

 

 

 
 

Station 1 (S7-300): 

The picture typical indicates, whether: 

 the station CPU is accessible (subscriber) 

 the last general request to the station was 
completed without error (GR), and 

 the time in the station is ok (Clock). 
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Screen  Description 

Details view 

 

 

In the details view, a general request can also 
be triggered (General request). From the TIM in 
the station, all data frames possibly still stored 
there can be transmitted as well as a current 
process image. 

 

Both further command options (Permanent 
connection on / off) are only relevant for a 
station connected via dialup network or 
dedicated line. 

 
 

Details view 

 

Station 2 (S7-1200): 

The picture typical indicates, whether: 

 the station CPU is accessible (subscriber) 

 the last general request to the station was 
completed without error (GR), and 

 the time in the station is ok (Clock). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the details view, a general request can also 
be triggered (General request). From the TIM in 
the station, all data frames possibly still stored 
there can be transmitted as well as a current 
process image. 

 

Both further command options (Permanent 
connection on / off) are only relevant for a 
station connected via dialup network or 
dedicated line. 

 

Display of the relevant messages (see 
description of the “Alarm” screen) 
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6.1.2 “Communication” screen 

The “Communication” screen shows the connection status of both substations. 
With this screen, two stations can be controlled and monitored. 

Table 6-2 

Screen Description 

 
 

Details view 

 

Station 1 (S7-300): 

The picture typical indicates, whether: 

 the station CPU is accessible (subscriber) 

 the last general request to the station was 
completed without error (GR), and 

 the time in the station is ok (Clock). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the details view, a general request can also 
be triggered (General request). From the TIM 
in the station, all data frames possibly still 
stored there can be transmitted as well as a 
current process image. 

 

Both further command options (Permanent 
connection on / off) are only relevant for a 
station connected via dialup network or 
dedicated line. 



6 Operating the Application 

6.1 Overview and description of the user interface 
 

SINAUT ST7 with CP 1243-8 IRC 
Entry ID: 109479747,    V1.0,    10/2015   70 
 


 S

ie
m

e
n

s
 A

G
 F

e
h

le
r!

 T
e

x
tm

a
rk

e
 n

ic
h

t 
d

e
fi

n
ie

rt
. 

A
ll 

ri
g
h

ts
 r

e
s
e

rv
e
d
 

Screen Description 

 
 

Details view 

 

Station 2 (S7-1200): 

The picture typical indicates, whether: 

 the station CPU is accessible (subscriber) 

 the last general request to the station was 
completed without error (GR), and 

 the time in the station is ok (Clock). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the details view, a general request can also 
be triggered (General request). From the TIM 
in the station, all data frames possibly still 
stored there can be transmitted as well as a 
current process image. 

 

Both further command options (Permanent 
connection on / off) are only relevant for a 
station connected via dialup network or 
dedicated line. 

 

Station 1 (S7-300): 

 

“Operating Mode”: Operating mode of the 
station 

– automatic mode 

– manual mode 

 

 

“Operating Status” 

– On: switched on 

– Off: switched off 
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Screen Description 

 

Station 2 (S7-1200): 

 

“Operating Mode”: Operating mode of the 
station 

– automatic mode 

– manual mode 

 

 

“Operating Status” 

– On: switched on 

– Off: switched off 

Note: 

In automatic mode, the operating status 
cannot be modified manually. 

 

6.1.3 “Archive” screen 

The process tags are stored in an archive. The “Archives” screen displays stored 
tags of the individual substations. 

Table 6-3 

Screen Description 

 

Station 1 (S7-300): 

Table with the stored values 
“OperatingMode” and “OperatingStatus” 

  

“Operating Mode”: 

“0”: automatic mode 

“1”: manual mode 

 

“OperatingStatus” 

“0”: Off 

“1”: On 

 

Station 2 (S7-1200): 

Table with the stored values 
“OperatingMode” and “OperatingStatus”  

 

“Operating Mode”: 

“0”: automatic mode 

“1”: manual mode 

 

“OperatingStatus” 

“0”: Off 

“1”: On 
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Screen Description 

 

Station 1 (S7-300): 

Display of the trends of the stored values 
“OperatingMode” and “OperatingStatus”  

: Operating Mode

: Operating Status
  

 

 

Station 2 (S7-1200): 

Display of the trends of the stored values 
“OperatingMode” and “OperatingStatus” 

: Operating Mode

: Operating Status
 

 

Joint display of the trends of station 1 
(S7-300) and station 2 (S7-1200) 

 

: Operating Mode Station 2

: Operating Status Station 2

: Operating Mode Station 1

: Operating Status Station 1

 

 

6.2 Watch tables “WT_SetPump” 

As an alternative to the WinCC user interface, the "WT_SetPump" watch table of 
the stations can be used for monitoring or controlling the tags of DB “DATA” (DB). 

Figure 6-2 Station 1_Tag_table “WT_SetPump” 
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Figure 6-3 Station 2_Watch_table “WT_SetPump” 

 

 

Note A description of the tags is available in Table 3-4. 
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6.3 Cyclic switching of the operating state of the pumps in 
automatic mode 

Requirements: 

 The ST7cc project was activated (see chapter 5.4.6) 

 St7cc and WinCC Runtime were started (see chapter 5.4.6) 

 The “Overview” screen was opened. 

Table 6-4 

No. Action 

1.  Go to the “Communication” screen. 

 

2.  Switch both stations to “Automatic mode”. 
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No. Action 

3.  After 30 seconds, the “Operating Status” of both stations is switched over 
automatically. 

 
Note: 

In automatic mode, the pumps cannot be operated manually. 

4.  You can view all of the archived values in “Archive” screen. 

 

: Operating Mode Station 2

: Operating Status Station 2

: Operating Mode Station 1

:  Operating Status Station 1

 

5.  Terminate the Ethernet connection between station 2 (S7-1200) and the central 
station and repeat steps 1-4 of this table. 
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6.4 Automatic switching of a pump (automatic mode), 
when changing the operating state of the second pump 
(manual mode). 

Requirements: 

• The ST7cc project was activated (see chapter 5.4.6) 

• St7cc and WinCC Runtime were started (see chapter 5.4.6) 

• The “Overview” screen was opened. 

Table 6-5 

No. Action 

1.  Go to the “Communication” screen. 

 

2.  Switch station 1 to “Manual mode” and station 2 to “Automatic mode”. 
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No. Action 

3.  Switch off the pump of station 1. 

 

4.  The pump in station 2 is automatically switched on. 

 

5.  You can view all of the archived values in “Archive” screen. 

:  Operating Mode Station 2

:  Operating Status Station 2

:  Operating Mode Station 1

:  Operating Status Station 1

 

6.  Terminate the Ethernet connection between station 2 (S7-1200) and the central 
station and repeat steps 1-5 of this table. 

 

Note The rules for station 2 (S7-1200) in automatic mode and station 1 (S7-300) in 
manual mode apply accordingly vice versa for station 1 (S7-300) in automatic 
mode and station 2 (S7 1200) in manual mode. 
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7 Links & Literature 
Table 7-1 

 Topic Title 

\1\ Siemens Industry 
Online Support 

http://support.industry.siemens.com 

\2\ Download page of 
the entry 

https://support.industry.siemens.com/cs/ww/en/109479747 

 

\3\ SIMATIC NET 
Industrial Remote 
Communication - 
TeleControl 
SINAUT ST7 
Station Control 
System 

https://support.industry.siemens.com/cs/ww/en/view/55639671 

\4\ SIMATIC NET 
SINAUT ST7 
Station Control 
System - System 
Manual 

https://support.industry.siemens.com/cs/ww/en/view/63112365 

\5\ WinCC V7.3: 
Communication 

https://support.industry.siemens.com/cs/ww/en/view/102691766 

\6\ SIMATIC NET 
S7-1200 - 
TeleControl CP 
1243-8 IRC - 
Operating 
Instructions 

https://support.industry.siemens.com/cs/ww/en/view/109478160 

\7\ SIMATIC NET 
Telecontrol 
SINAUT ST7cc 
Control Center 
Software Manual 

https://support.industry.siemens.com/cs/ww/en/view/63203610 

\8\ WinCC V7.3: 
Working with 
WinCC 

https://support.industry.siemens.com/cs/ww/en/view/1027549
25 

\9\ MD2 dedicated 
line modem 

https://support.industry.siemens.com/cs/ww/en/view/1716379
9 

 

8 History 
 

Table 8-1 

Version Date Modifications  

V1.0 10/2015 First version 

   

   

 

http://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/109479747
https://support.industry.siemens.com/cs/ww/en/view/55639671
https://support.industry.siemens.com/cs/ww/en/view/63112365
https://support.industry.siemens.com/cs/ww/en/view/102691766
https://support.industry.siemens.com/cs/ww/en/view/109478160
https://support.industry.siemens.com/cs/ww/en/view/63203610
https://support.industry.siemens.com/cs/ww/en/view/102754925
https://support.industry.siemens.com/cs/ww/en/view/102754925
https://support.industry.siemens.com/cs/ww/en/view/17163799
https://support.industry.siemens.com/cs/ww/en/view/17163799
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